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Chapter

1

What's New in Solid Edge ST4

Solid Edge ST4 builds on a single system of synchronous and ordered features so
designers need not make a choice. Here are the major areas of improvement.

| Part and sheet metal enhancements

Advanced machine design capabilities in Solid Edge part and sheet metal provide:

e A better workflow for modeling revolved features, including automatically
creating Live Sections that retain the 2D dimensions.

e Fully synchronous rib and web network creation and editing.
e More precise hole placement and PMI dimension placement on cylinders.

To learn more, see Part and sheet metal enhancements.

] Assembly enhancements

Many enhancements to process applications—tubes, paths, and Standard Parts—are

available in ST4. New face relationship commands include 3D Offset and 3D
Horizontal and Vertical. The Relate command has been replaced by a new Face
Relate group.

To learn more, see Assembly enhancements.

| Draft enhancements

ST4 provides many substantive enhancements to text formatting, annotation
symbols, tables, and drawing view captions. While supporting the ESKD and GB
drawing standards many of our customers use, these changes are universally
available to all drawing standards.
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See Draft enhancements.

] User interface enhancements

User interface enhancements include behavioral improvements in the orientation
triad, keypoints, keyboard shortcut commands, and the mouse wheel.

You can communicate designs better and faster with out-of-the-box photorealistic
rendering, including view style support for reflections, mirror floor, cast shadows,
and granular perspective control.

To learn more, see User interface changes.

% Finite element analysis headlines

Solid Edge Simulation enhancements focus on sheet metal design, so you can analyze
machines with sheet metal parts. These improvements provide greater accuracy for
smaller models, and they bolster support for hybrid surface and solid models.

¢ A new Simulation Geometry tab in assembly provides direct access to surfacing,
modification, and curve commands to simplify the assembly model.

¢  You now can use two types of Edge connectors—Rigid or Glue—to create more
realistic connections between 2D shell and solid elements.

¢ Many new meshing and sizing options generate more accurate meshes.

e Solid Edge Simulation is now available for structural frame models.

See New in Solid Edge Simulation.

% Document management headlines

Document management in ST4 provides expanded collaboration with suppliers
and customers. Now you have:

¢ The ability to drag a neutral-format JT CAD model directly into a Solid Edge
assembly document to leverage vendor and supplier data.
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e RKasier tracking and incorporation of design changes with automatic item
number and file name synchronization.

¢ Document types not native to Solid Edge, such as STEP, X_T, and IGES, can now
be opened in the managed environment.

See Document management enhancements.

] Printable What's New documentation

A standalone book of What’s New in Solid Edge ST4 is available in the Help pane.
To find it:

1. On the ribbon, click the Help index icon ﬁ
2. In the Help pane, under Solid Edge Help, select What’s New.

You can print the entire What’s New help book, a selected book, or individual topics
in What’s New.

¢ To print the full What’s New book, on the Contents page, right-click the topmost
book, What’s New in Solid Edge ST4, and then choose Print.

¢  You can print individual books or topics in What’s New using the same technique.
Tip

You can control pagination better by selecting and printing books individually.

| Online self-paced training

Access to self-paced training is available online at no charge. Working at your own
pace, from your own desktop, teach yourself the basics of synchronous part and
assembly modeling and drafting with these overviews, animations, and activities.

From within Solid Edge, the link to self-paced training is located on the Help pane.
To find it:
1. On the ribbon, click the Help index icon i

2. In the Help pane, under Learning Tools, select Solid Edge Self-Paced Training.
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Sketching enhancements

These enhancements were made to sketching in Solid Edge ST4.
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[ Closed option for Curve command

Closed option for Curve command

When drawing or sketching, a new Closed option on the Curve command bar creates
closed, B-spline curves.
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For more information, see the Curve command Help topic.
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Part and sheet metal enhancements

These enhancements were made in the Part and Sheet Metal environments in Solid
Edge ST4.

250

Relate command user interface changes

New relationship command: Offset

New centering relationship command: Horizontal and Vertical
Selection Manager

Selecting features enhancement

Revolved feature creation workflow enhancement

Live Section option added to the revolve extrusion command bar

Dimension to the center of a rib or web feature

Improvement for precise placement of holes on cylinders
Move to Synchronous enhancements

Material and gage table enhancements

Relate command user interface changes

The Relate command user interface has changed. The Relate command is no longer

available on the Move command bar. There is a new group on the ribbon named Face
Relate. The Face Relate group contains all of the face relationship commands. Each

face relationship command has its own command bar.

For more information, see the Help topic Defining relationships between model faces.
Note

Self-paced training is available online for applying face relationships. Look for
the Working with face relationships course (spse01525).
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New relationship command: Offset

Makes selected face(s) parallel to target face and applies a user-defined offset
distance.

The offset relationship is persisted by default. You can turn the persist option off
while in the command.

For more information, see the Help topics:
Defining relationships between model faces
Offset command

Note

Self-paced training is available online for applying face relationships. Look for
the Working with face relationships course (spse01525).

New centering relationship command: Horizontal and Vertical

Use the horizontal/vertical command to make a selected planar face (A) parallel to
the most similar base reference plane (B).

You can also apply a horizontal/vertical constraint between two keypoints (A), (B)
relative to a reference plane.
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During the establishment of a horizontal/vertical relationship, only the seed face(s)
or the seed keypoint move (C). A target keypoint (B) does not move during a relate
operation.

The horizontal/vertical relationship is persisted by default. You can turn the persist
option off while in the command.

For more information, see the Help topics:
Defining relationships between model faces
Horizontal and Vertical command

Note

Self-paced training is available online for applying face relationships. Look for
the Working with face relationships course (spse01525).
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Selection Manager

Selection Manager must now be explicitly invoked by one of the following ways:
¢ Press the Shift + Spacebar keys.

¢  On the Home tab, in the Select group, in the Select drop list, choose the Selection
Manager Mode command.

Press the Spacebar to exit the Selection manager mode.

For more information, see the Help topic Selecting elements using the Selection
Manager.

Selecting features enhancement

There is a new feature selection tool for editing single value features (rounds, equal

offset chamfers, draft, thin walls and break corner). This will easily allow the entire
single value feature to be edited directly without needing a PathFinder or QuickPick
selection.

Modify a single value driven feature as:

e An entire feature
¢  Only selected face(s)
e All similar faces in the model

For more information, see the Help topics:
Editing single value driven features

Edit a single value driven feature

Revolved feature creation workflow enhancement

You can now drag the origin of the extrude handle to a linear element to start the
revolve extrusion command. This enhancement reduces steps required to create a
revolve feature. The previous revolve workflow is still available.

For more information, see the Help topics:

Constructing revolved features using the Select tool

Revolved Extrusion command

Construct a revolved extrusion: base feature

Construct a revolved extrusion or cutout: subsequent features

Revolved Extrusion command bar

Live Section option added to the revolve extrusion command bar

When creating a revolve feature, a Create Live section option is available on the
command bar. This option is on by default. All sketch dimensions migrate to the
live section.

For more information, see the Help topics:
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Constructing revolved features using the Select tool

Dimension to the center of a rib or web feature

Ribs and web networks now are available as fully synchronous features in their
creation and editing. In addition, you can:

¢ Place symmetrical dimensions to the rib or web thickness.

e Place dimensions to the center of a rib or web feature.

5

To learn how, see these Help topics:
Editing a synchronous Web Network feature

Editing an ordered Web Network feature

Improvement for precise placement of holes on cylinders

The tangent plane command is now available within the Hole command. If the
cursor moves over a cylinder, pressing F3 starts the Tangent plane command. You
can control the angle of the tangent plane.

When dimensioning between two holes that intersect a cylinder, the center lines of
the two holes are used to place a distance between dimension.

Move to Synchronous enhancements

Enhancements to the Transition to Synchronous command include:

¢ In sheet metal, the Move to Synchronous command now supports the moving
of dimensions and local profile sketches from the ordered environment to the
synchronous environment. In previous versions, the moving of dimensions and
local profile sketches was supported only in part.

¢ In part, the Move to Synchronous command now supports the moving of auto
dimensions from the ordered environment to the synchronous environment.
Auto dimensions are those dimensions automatically created by Solid Edge, such
as extent dimensions in a protrusion.

For more information, see the Help topic Moving ordered features to synchronous.

Material and gage table enhancements

Several enhancements have been made to materials and gage tables:
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¢  You can store sheet metal gage information in the material library or in a
Microsoft Excel file.

¢ A new Associate Gage Table option has been added to the Material Table dialog
box to map a gage file and gage table to a material or document. The gage file is
an Excel file that contains sheet metal gages in a gage table, which is a sheet
in the Excel file. Solid Edge delivers a default gage file, Gagetable.xls, to the
Solid Edge ST4 Program folder.

¢ A new Use Neutral Factors from Excel File option has been added to the Gage
tab of the Material Table dialog box to use neutral factors stored in an Excel file.

For more information, see the Help topic Material Table command.
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Assembly enhancements

These enhancements were made in the Assembly environment in Solid Edge ST4.
The changes apply to all assembly models.

Path command now available in XpresRoute

Relate command user interface changes

New relationship command: Offset

New centering relationship command: Horizontal and Vertical
Positioning parts: Center—Plane offset

Positioning parts: Range offset value

In place activation: Extrude faces

Display and Rendering

Assembly Steering Wheel

Fastener system enhancements

Standard Parts enhancements

Undo command enhanced in assembly

Automatic Update command enhanced in assembly
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[ Annotation flow lines in exploded views

E Tubes enhancements

Keypoint Curve Segment command now available in XpresRoute

The Keypoint Curve Segment command is now available in XpresRoute so you can
create a keypoint curve segment (A)...

Relate command user interface changes

The Relate command user interface has changed. The Relate command is no longer

available on the Move command bar. There is a new group on the ribbon named Face
Relate. The Face Relate group contains all of the face relationship commands. Each

face relationship command has its own command bar.

For more information, see the Help topic Defining relationships between model faces.
Note

Self-paced training is available online for applying face relationships. Look for
the Working with face relationships course (spse01525).

New relationship command: Offset

Makes selected faces parallel to target face and applies a user-defined offset distance.

The offset relationship is persisted by default. You can turn the persist option off
while in the command.

For more information, see the Help topics:

Defining relationships between model faces
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Offset command
Note

Self-paced training is available online for applying face relationships. Look for
the Working with face relationships course (spse01525).

New positioning relationship command: Center-Plane Offset

The midpoint can be found between geometry, such as the distance between two
planes, faces or key points, and this can be used to position the part, much like a
mate or planar align. Previously, either a reference plane was needed in the part to
define the midpoint, or an offset needed to be calculated.

The offset relationship is persisted by default. You can turn the persist option off
while in the command.
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In the example below, the center cylinder on the latch is always centered between
the cylinders on the outside regardless of if the latch is open or closed.

For more information, see the Help topics:

Center-Plane command

In place activation: Extrude faces

When in place activated from within an assembly, you can now select faces from
other parts as the source for non associative extruded features.

Display and Rendering

Improvements to the model view display for part, sheet metal and assembly
environments are:

¢ Reflective Floor display, where the floor is computed by the orientation of the
model and recomputed if the view rotates.

¢ Additional view styles, such as high quality, to be used for better model display.
¢ Display commands which can override one setting leaving the remaining

unchanged. An example, select the high quality view style, then turn on or
off the reflective floor.
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Improvements to Virtual Studio include:

e New 2D Schemes (HDR) with 2d backgrounds and lighting improvements

New 3D Schemes (HDR) with 360 backgrounds and lighting improvements. The

3D schemes rotate relative to the view.

Note

These 3D scenes are not displayed during real time rotations. The scene
will need to be rendered again to see the scene.

e Four levels of quality are provided for the enhancements. These are:

High Quality HDR
Medium Quality HDR
Draft HDR

Ambient Occlusion (AO)

e New Schemes:

Release-Notes-1040

Interior Schemes
Exterior Schemes

Studios
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— 2D Abstract Backgrounds and Reflections
— 2D Exterior Back plates

— 2D Interior Back plates
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Assembly Steering Wheel

New functionality for steering wheel manipulation and selection of synchronous
geometry in the assembly environment includes:

e Move with auto relate option. Changes mate relationships to floating and
attempts to find and restore or create relationships upon completion.

e Move and Copy with auto relate option. Copied components attempt to create
unsatisfied relationships upon completion.

e Move component and related faces options. Selects the faces in the synchronous
part model that the component is related to for manipulation.

Release-Notes-1040 ST3 Release Notes 117



Chapter 1 What’s New in Solid Edge ST4

An option exists to allow for this functionality to be used in subassemblies.

New positioning relationship command: Range Offset

Now an offset can be created to control the range of allowable motion in relationships
such as mate, planar align, axial align and more.

Note

Range offsets are not intended to be used for geometric tolerances, as over
constrained components can occur.
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New centering relationship command: Horizontal and Vertical

Use the horizontal/vertical command to make a selected planar face (A) parallel to
the most similar base reference plane (B).
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You can also apply a Horizontal/Vertical constraint between two keypoints (A), (B)
relative to a reference plane.
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During the establishment of a horizontal/vertical relationship, only the seed face
or the seed keypoint move (C). A target keypoint (B) does not move during a relate
operation.

The horizontal/vertical relationship is persisted by default. You can turn the persist
option off while in the command.

For more information, see the Help topics:
Defining relationships between model faces
Horizontal and Vertical command

Note

Self-paced training is available online for applying face relationships. Look for
the Working with face relationships course (spse01525).
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Fastener system enhancements

Several enhancements have been made to Fastener Systems:

¢  With enhancements to the Fastener Systems dialog box, you can now:

Preview the fastener before adding it to the stack.
Preview the fastener in the assembly prior to saving your changes.
Save and recall fastener component settings.

Display the Standard Parts dialog box so you can select fasteners from a
standard parts library.

Copy fasteners from the database and save them to the local working folder
or the active assembly folder.

Display properties and characteristics, such as Part Name or Revision, for
fasteners prior to selecting the fastener.

Use the Top Hole by Plane option to place a fastener into a slot.

e With the new Flip option on the Fastener System command bar you can flip the
part to the opposite side of the tangent face or plane.

¢ In the Draft environment, you can create automatic balloon stacks for fasteners
with a single click.

ST3 Release Notes
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Standard Parts enhancements

Several enhancements have been made to Standard Parts:

With enhancements to the Category dialog box, you can now:

— Add a new category to an existing category.
— Rename an existing category.

— Remove an existing category.

For more information, see Generate parts in a category and modify a
category.

Drop lists have been added to the Piping and Fastener Systems tabs on
the Standard Parts Part Editor dialog box so you can set or edit Part Type
information based on the select pipe or fastener type.

A new Frames tab, containing a drop list, has been added to the Standard Parts
Part Editor dialog box so you can set or edit Part Type information for frame
components.

British Standard (BS) components are now delivered with the free sample and
library databases.

Undo command enhanced in assembly

The Undo command in assembly has been enhanced to support assembly features
such as pipes, frames, wires, assembly features, and weld beads. The Undo command
also supports the Delete command for these features during create and edit of the
features. Undo does not support assembly-driven part features and the Update All
Links command.

Automatic Update command enhanced in assembly

The Automatic Update command has been expanded in assembly to support:

Frames

Pipes

Wires

Assembly features
Profile

Edit sketch
Adjustable parts

Drag components

For these features, you no longer have to click the Update All Links command to
update any edits.

Release-Notes-1040
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The Automatic Update command does not support:

* Assembly-driven part features
¢ Tubes

e  Wires created in previous versions

Note

If you turn the Automatic Update command off you must select the Update All
Links command to update any edits.

Annotation flow lines in exploded views

A new type of flow line has been created for annotation purposes for an exploded
view. In addition to event flow lines that are created when an assembly is exploded,
annotation flow lines can be created to independently enhance exploded view
creation in draft documents. Annotation flow lines can be saved in a display
configuration so that they can later be used to create a drawing of the exploded
view. Unlike event flow lines, annotation flow lines do not control the sequence of
events for animation purposes.

Some of the new functionality for annotation flow lines are:

¢ (Creating new flow lines
e Pathfinder control for display of selected flow lines

¢ Modifying the position of annotation flow lines by dragging handles
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Keypoints on activated parts can be used to accurately position annotation flow
lines

The display of flowline arrowheads can be turned on or off

Annotation flow lines can be oriented to follow the axis of a part

Tube enhancements

Tube enhancements include:

Release-Notes-1040

The options on the General and File tabs on the Tube Options dialog box have
been merged into a single General tab.

The Material option on the General tab of the Tube Options dialog box is now
populated from the Material Table. Previously, the option applied a face style
override, but now it applies the material properties to the tube part file.

If a material is specified in the template you use to create the tube, it is the
default material for the tube. If no material exists in the template, the default
material is the material used when the last tube was created. If there was no last
used material, the default material is Copper, if Copper exists in the Material
Table. If Copper does not exist in the Material table, the default material is None.

Note

If you click OK on the Tube Options dialog box with Material set to
None, a warning dialog box indicates that the tube file has no density,
which causes the physical property calculations for the assembly to

be inaccurate. To correct the problem, you can select a material with a
defined density or you can leave the material without a defined density.

ST3 Release Notes 1-25



Chapter 1 What’s New in Solid Edge ST4

PMI enhancements

These enhancements were made to PMI dimensions and annotations in Solid Edge
ST4.
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Section view application now controlled via PathFinder

[ Consistent PMI text and break line size during zoom

Section view application now controlled via PathFinder

The application of section views is controlled via check boxes located to the left of the
individual section names. See Apply or remove a section cut for more information.

Consistent PMI text and break line size during zoom

When you set PMI text size using the Pixel Size PMI command, the PMI text, break
line, and break line gap now maintain a consistent size when you zoom in and out
of the graphics window.

You can set the break line size as a ratio of text size on the Lines and Coordinates
page in the Dimension Style dialog box and in the Dimension Properties dialog box.
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New in Solid Edge Simulation

The Solid Edge Simulation application is available for all Solid Edge models. These
enhancements were made in ST4.
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New mesh type: Beam

Simulation available for structural frame models

Assembly connector symbol changes

Displacement load automatically generates constraint
Failed-mesh problem identification and resolution
New type of edge connector

Glue and no penetration contact connector workflow enhancements
Geometry selection using PathFinder

Improved post-processing numerical formatting
Material changes do not require remeshing

Material reference temperature for studies

Model optimization tools for assemblies

New material property command

New meshing options

New mesh type: United Bodies

Improved sheet metal and surface analysis in assemblies

ST3 Release Notes
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[ Simulation report in Adobe PDF format

New mesh type: Beam

A new mesh type—Beam—is available in the Create (or Modify) Study dialog box
when you create a study for assembly models.

With beam meshing, you now have a 1D mesh element type suitable for modeling
individual structural members such as beams and rods, as well as frameworks used
in truss design and equipment support.

Simulation available for structural frame models

Now you can use Solid Edge Simulation to analyze a structural frame model.

When working in the Frame environment, and when you have a valid Solid Edge
Simulation license, the Simulation tab is displayed on the ribbon.

Several new commands have been introduced into Simulation specifically for frame
analysis:

e Moment load: You can define bending moments on beam members.
e Node: You can place explicit nodes along beam members.

¢ Release: You can release degrees of freedom at the ends of beams.
Example

You can simulate a ball joint by releasing the three rotational degrees
of freedom at the end of a beam.

Several new options exist in the Simulation Results environment:
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e Beam Cross Section: You can display the beam cross section with results.
e Beam Diagram: You can display the beam diagrams along members.

¢ Beam End Reactions: You can compute and display beam end reactions such as
moments, shear forces, axial forces, and torques.

Assembly connector symbol changes

In Solid Edge Simulation ST4, it is easier to identify whether an assembly connector
symbol is on the target side of the connection or the source side of the connection.

e Symbol differentiation

The connector symbols are color coded to make it easier to identify the target
faces and source faces.

The default colors are set on the Simulation page (Solid Edge Options dialog box).

Connector target
Connector symbols on the target side of the connection are red.

During editing, faces on the target side of the connection highlight in red.

Connector source
Connector symbols on the source side of the connection are blue.

During editing, faces on the source side of the connection highlight in blue.
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e Optimized symbol location

To give a better indication of the contact area, connector symbols now appear
only where two faces or surfaces actually touch or may come into contact.

Displacement load automatically generates constraint

A new option on the Loads command bar automatically generates a pinned
constraint on the same faces, edges, or vertices where a displacement load is placed.
This satisfies the NX Nastran requirement for enforced displacement, and speeds
the process of defining the displacement load.

The Pinned constraint button on the Loads command bar is selected by
default when you choose the Displacement load command.

Failed-mesh part identification and resolution

There are several enhancements to Solid Edge Simulation failed-mesh error
identification and resolution.

¢  When meshing fails on an assembly model, the error message dialog box now
lists the pass-fail state of each part and component in the study.

¢ A new button on the dialog box provides direct access to the Geometry Inspector,
with only the failed objects automatically selected.

To learn how to use the Geometry Inspector in Solid Edge Simulation to remove
geometry flaws and small entities, see the help topic, Optimizing models for
finite element analysis.

e  When the model is meshed again, only the changed parts and components are
reprocessed. This greatly reduces the time required to update the mesh.

Glue and no penetration contact connector workflow changes

There are several new options on the Assembly Connector command bar that apply
to placing glue and no penetration contact assembly connectors using the Manual
connector command. You also can edit a glue or no penetration connector to replace
the target or source faces in the connection.

¢ One or multiple faces selection option
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(B
Use the Select Multiple option HE on the Assembly Connector command bar
to specify whether you want to place a single connector between two faces or
between many faces.

¢ Improved search distance algorithm

To reduce instances where NX Nastran fails because the model is not sufficiently
constrained, non-penetration connectors now are created using up to three times
the specified search distance. This accounts for surfaces that are not initially in
contact but may come into contact later due to deformation.

¢ Two symbol color editing buttons

When placing or editing a manual assembly connector, you can change the
default colors assigned to the target side of the connection and the source side of
the connection using two color buttons on the Assembly Connector command bar.

To learn more, see the Glue and no penetration contact connectors overview.

Material changes do not require remeshing

In ST4, changing the material or editing a property of a material causes the study to
go out of date, but it does not require remeshing. You only have to choose the Solve
command to update the simulation results with the new or edited material.

The study status indicator goes out of date only for the results process:

®—D

Only the Results node in the Simulation pane displays the out-of-date indicator:
oL
This applies to part, sheet metal, and assembly models.

Material reference temperature for studies

On the Simulation page (Solid Edge Options dialog box), you can set a reference
temperature as a property of the materials used in a part, sheet metal, or assembly
study. In a model with mixed materials, the same reference temperature is applied
to all materials.

This material temperature property is saved with the study. It is used to determine
the amount of stress and displacement due to the expansion and contraction of the
materials in the model.

To learn more, see Using a material reference temperature in Using materials in
studies.

Model optimization tools for assemblies
Now you can select geometry creation and modification commands directly from an

assembly document to optimize 2D and 3D model geometry. Previously, you had to
open the part or subassembly models to prepare the assembly for analysis.
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When you have a Solid Edge Simulation license, a new Simulation Geometry tab is
displayed in the Assembly environment. The following options are on the Simulation
Geometry tab:

¢ Surfacing group

Contains familiar surfacing commands to create or modify a mid-surface, copy
surfaces from a part or sheet metal model into the assembly, offset surfaces, and
extend, trim, and stitch surfaces together to produce one continuous mesh.

¢ Unite Bodies, Recover Bodies commands

Contains two new commands—Unite Bodies and Recover Bodies—that may be
used to combine surfaces and solids within the assembly document into one body.
A united body produces a continuous mesh, which produces better simulation
results.

e Modify group

Provides commands to move, rotate, and delete faces and surfaces.

e Curves group

Provides commands to project one or more 2D or 3D curves onto a surface or
set of surfaces.

The Simulation Geometry tab also contains familiar commands for selecting surfaces
and taking 3D measurements using PMI dimensions.

To learn more about how you can use these commands to optimize an assembly,
see the following topics in online help:

¢ Assembly best practices for simulation.

e Activity: Simplify a sheet metal assembly

Geometry selection using PathFinder

There are improvements to geometry selection in part, sheet metal, and assembly
models for ST4.

¢  You now can use PathFinder to select geometry as input:

— When defining new studies, loads, constraints, and manual assembly
connectors.

— When using the Surface Sizing command to refine the mesh.
Previously, you could select geometry only using the graphics window.

e  With a Surface mesh type, you can select face sets and features in PathFinder to
define the following loads and constraints:

— For these load types:

Force and Displacement

— For these constraint types:
Fixed, Pinned, No, Rotation, and User-Defined
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¢  You can double-click many simulation objects in the Simulation tree-view pane
to edit them.

Improved sheet metal and surface analysis in assemblies

Now you can create and modify mid-surfaces, faces, and surfaces for analysis directly
from the assembly model. A new Simulation Geometry tab provides access to the
standard surfacing commands, as well as provides access to two new ones:

e Unite Bodies
* Recover Bodies

The Simulation Geometry tab replaces the Surfacing tab in the Assembly
environment in Solid Edge Simulation.

To learn how you can use the commands on the Simulation Geometry tab to get
better results from assembly models that contain sheet metal parts and surfaces,
see the following help topics:

* Preparing and selecting united bodies for studies

¢ Assembly best practices for simulation in the Simulation model optimization
book.

Improved post-processing numerical formatting

In the Simulation Results environment, you can select the following numerical
formatting options using the Color Bar tab®Format group®Number Format list:

e Automatic
e Scientific
¢ Floating

In ST4, the Automatic option automatically selects the best possible numerical
format for each of the following values, instead of using the same format for all:

¢  When using the Probe command, the node values displayed in the Probe Table,
and the node locations displayed in the graphics window.

See Probing analysis results.
¢ The numbers displayed in the color bar column.

See Using the color bar.

New type of edge connector

The Simulation tab®Connectors group®Edge command o now offers two options
for creating connections:

¢  When Connector Type is set to Glue, you can create connections between nodes
on edges and faces using a defined search distance and penalty factor.
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Note

This differs from the Manual connector command (Glue), which creates
connections between faces and surfaces.

¢  When Connector Type is set to Rigid, you can create rigid connections between
nodes on edges.

You can choose Glue or Rigid from the Connector Type list on the Assembly connector
command bar.

To learn more, see the Edge connectors overview.

New material property command

Two commands are available to adjust the material thickness—the mesh
thickness—on the model.

¢ Override Property command

You can use the new Simulation tab®Geometry group®OQOverride Property
command to apply a different material or material thickness to individual faces
or surfaces. The Override Property command is available in a study with one
of the following mesh types:

—  Surface
—  United Bodies
— Mixed and United Bodies

Previously, you could only adjust the material thickness on bodies.

See the following help topics:
— Mesh material properties.
— Override mesh properties on faces

e Edit Thickness command

You can use the existing Edit Thickness command to apply a different material
thickness at the object level in sheet metal parts or in assemblies that contain
surfaces or mid-surfaces.

The Edit Thickness command is available from the shortcut menu of the
Thickness node in the Simulation tree-view pane.

See the help topic, Change the study material or thickness.

New mesh type: United Bodies

A new mesh type—United Bodies—is available in the Create (or Modify) Study
dialog box when you create a study for part and sheet metal models. When creating
a study for an assembly model, you can use the Mixed and United Bodies mesh type.

United bodies meshing produces a continuous mesh for solids and surfaces united
into single bodies. Use this to mesh parts with T-shaped junctions.
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Example

T-shaped junctions at (A) and (B).

(B)

To learn how you can use united bodies to improve meshing, see Assembly best
practices for simulation in the Simulation model optimization book.

New meshing options

A variety of new meshing options are available to improve a new mesh using the
Mesh command or when refining a mesh using one of the mesh sizing commands.

¢ The new Mesh Options dialog box contains tab options for Mesh Sizing, Solid
Mesh, and Surface Mesh sizing. You can open this dialog box using the Options
button in the Mesh dialog box.

B ' Tetrahedral Mesh I&

Subjective mesh size:

U

1 - Coarser 10 - Finer

[ Mesh ] [ Mesh & Solve ] [ Options ]

L

¢ Options that you select in the Mesh Options dialog box are applied and saved
with the study when you select either of the following buttons to mesh the model:

— Mesh

— Mesh & Solve
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In addition, when refining the mesh on a surface using the Surface Size
command, mapped meshing options are available on the Surface Size command
bar. Mapped meshes often result in a mesh with regular, structured elements.

You can apply a mapped mesh between three or four corners that you specify,
resulting mostly in quadrilaterals, or you can apply a mesh that has triangles
at one corner.

Simulation report in Adobe PDF format

Now there are four report formats available for creating an analysis report in the
Simulation Results environment. The newest is the Adobe PDF format.

You can choose the report format in the Create Report dialog box.

Use integrated self-paced training and help in Solid Edge Simulation

In Solid Edge Simulation, you can find self-paced training activities and user help in
a single, self-contained online file. This has the unique advantage of providing links
between the two types of user assistance.

Invoking help—You can display the dedicated Simulation Finite Element
Analysis Help and Training by doing any of the following:

—  When the Simulation tab is displayed, press F1. Use this help topic to get
started: Analyze a model.

— When the Simulation Results environment is active, press F1. Use this help
topic to get started: Review analysis results.

— Click the Help Index button i to display the Help pane, and then choose
the Solid Edge Simulation Finite Element Analysis Help and Training link.

Self-paced training activities are located in the Practice book in help. You can

use the Hide button to reduce the window size while you work through
the activities.

Self-paced training models for simulation activities are located in the
C:\Program Files\Solid Edge ST4\ Training\Simulation folder.

You can ask questions or send us feedback about the depth and scope of
user assistance using the new e-mail links at the bottom of most Solid Edge
Simulation topics.
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Document management enhancements
Document management capabilities within Solid Edge Embedded Client, Structure
Editor, and Insight Connect, are enhanced to support Solid Edge ST4.
Software Compatibility
Solid Edge Embedded Client ST4 supports:
e Teamcenter Express v5.3.1
e Teamcenter 8.1.1.3 and 8.1.2.0
e Teamcenter 8.3.1.1, and 8.3.2.0

e Teamcenter 9.0

Solid Edge Embedded Client ST4 is not supported with:

e Teamcenter 8.2

e Teamcenter 2007.2

¢ Teamcenter 2007.1

¢ Teamcenter Engineering

e Any Teamcenter Express version based on any of the above.

Special action for Teamcenter Express v5.3 administrators

For this release, special action is required for Teamcenter Express administrators.
Teamcenter Express v5.3 administrators must update to the SEEC Overlay
Templates delivered with SEEC Administrator ST4. Teamcenter Environment
Manager (TEM) provides the mechanism to update deployed templates. Be sure to
use the template Teamcenter 8.3. For instructions, refer to the Solid Edge Embedded
Client Administrators Guide. Look for Updating the Solid Edge Embedded Client
Overlay Template with Teamcenter Express V5.3.

Primary Business Objects (PBO)

Primary Businesss Objects (PBO), new with Teamcenter 8, are supported for adding
attributes to COTS classes (Item and Item Revision). You can create custom classes
and add attributes. Additionally, attributes designated as required must have
default values.

Support for single sign-on

Any Solid Edge application that requires a Teamcenter logon (ie. Solid Edge
Embedded Client, Structure Editor, Add to Teamcenter) can take advantage of
Teamcenter Security Services using single sign-on, provided that an SSO enabled
database is activated. When you use single sign-on, you log onto a Teamcenter
enabled single sign-on application. Then the next application uses those credentials
and submits them to the authentication authority. You are not required to log on
again.
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Note

Teamcenter Security Services is not delivered or supported with Teamcenter
Express.

For more information, see the Define single sign-on enabled Teamcenter database
help topic.

Solid Edge Assembly Item Numbers are integrated with Teamcenter
Product Structure’s Find Numbers (Find No.)

The integration of Solid Edge Assembly Item Numbers with Teamcenter

Product Structure’s Find Numbers is governed by a new Teamcenter preference,
SEEC_Synchronize_ItemNumbers. With the use of the preference, Item Numbers
defined in Solid Edge are saved to the Teamcenter Bill of Materials, and those same
Item Numbers are available to Solid Edge Draft.

For more information, see the Item numbers in assemblies help topic and the
Teamcenter Preferences section of the Solid Edge Embedded Client Administrator’s
Guide.

Create, update, and retranslate STEP, X_T, and IGES

Document types not native to Solid Edge, such as STEP, X_T, and IGES, can now
be opened in the managed environment. The translated file is presented in the
New Document common property dialog box where you can assign all the necessary
attribute information and then save the new document to Teamcenter.

File name alignment

During translation of a foreign document (STEP, X_T, IGES) into the
Teamcenter-managed environment, file names are automatically aligned with the
Item ID in the Common Property Dialog boxes. A Link Fix-up is performed for you.
This process eliminates the potential for clashing file names in the cache when
the foreign documents are opened in Solid Edge. This process is also used when
unmanaged documents are dragged from the Parts Library tab into a managed
document. For more information, see the Opening foreign files in Solid Edge and
Open a foreign file in the Teamcenter managed environment help topics.

Multi-CAD support using JT

While the JT document format has been considered an output format, now you
can leverage JT as input to a managed product development process allowing data
from multiple CAD systems to be integrated into a single design. The Teamcenter
preference, SEEC_Foreign_Datasets is used to define the foreign data source.

This workflow introduces the concept of a driven reference where a document’s
geometry is defined by a non—Solid Edge source. The driven reference is read-only
and goes through an out-of-date check. If the foreign source changes, the change
is synchronized the next time the file is opened. The driven reference is uniquely
identified in Assembly PathFinder.

For more information, see the Multi-CAD in the Teamcenter managed environment
help topic.
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Search performance enhanced

A new preference, SEEC_Search_Limit, sets a limit for the number of items returned
during a search. When the number of items found is greater than the limit specified,
you have the option to modify the search criteria, view only the number of items
defined by the preference, show all search results, cancel the query in progress, or
cancel the search. For more information, see the Teamcenter Preferences section of
the Solid Edge Embedded Client Administrator’s Guide.

Multicache warning

In some cases, a single document can exist in multiple cache locations. For example,
when you open a document on one computer, then open the same document on
another computer, the document is in the cache of the two computers. With this
release of Solid Edge Embedded Client, you are now warned when this condition
exists in order to prevent any loss of data. The warning informs you that the
document is checked out to you, but not checked out in the local cache. You are
given the option to either continue opening the document or to cancel the command
to open the document.

Item Types

You no longer have to edit the preference

TYPE _DISPLAY_RULES list_types_of_subclasses to see Item Types. A new SOA
API performs this function for you. You only need to use the SEEC_ItemTypeList_*
to limit the list shown.

Visual enhancements

When you work with lists, the color variation is enhanced to make it easier for you to
determine an active, but out of focus selection. The color is increased in luminosity
and decreased in saturation. So, for example, dark blues become lighter and greyer
while entries that display in black become lighter when not selected.

New Insight Server tools

Two new Insight Server tools provide you with a way to prepare your Insight Servers
for restoration from a backup or for migration to a new SharePoint version. The
Remove Insight Full Text Index and Restore Full Text Index commands are available
from the Insight Server Start menu.
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Draft enhancements

1-40

These enhancements were made in the Draft environment in Solid Edge ST4.

Annotation symbol enhancements
Associative sheet scale from first drawing view

Automatic balloon stacks for fasteners

Automatic labeling and sorting for view annotations

Balloon stack edit handles
Break line enhancements for broken views

Callout text formatting enhancements

Callout edit handles

Closed option for Curve command
Control rib hatching in section views

Dimension enhancements

Drawing view caption enhancements
Empty-callout visibility

Feature control frame improvements
Handles for reattaching center lines

Leader command enhancements

Line style control for boundary edges

Locked drawing views
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%] New command: Copy Attributes

E New command: Set Sheet Scale

%] New style: Drawing View
] New style for hatches and fills: Wood (radial)

E Parts list and table enhancements

[ Show drawing view geometry during move
fel Support for GB and ESKD drawing standards
[ Text box formatting enhancements

[ Undo and Redo for deleted drawing views

fel Printing enhancements

Annotation symbol enhancements

Expanded symbol library

The Solid Edge ST4 symbol libraries have been expanded to support drawing
standards and customer requests:

e ANSI ASME Y14.5-2009 and the ISO equivalent

New symbols in this category include those for Translation, Independency,
Continuous Feature, and All Over.

¢ Customer requested symbols

New symbols in this category include the Oval and Rectangle, as well as
Centerline and Parting Line.

e ESKD drawing standard
Additional symbols in this category include Rotated View.

¢ GB drawing standard

Additional symbols in this category include Rotated View, Taper Angle symbols
for all four directions, the Symmetric Taper Angle, and Three Sided Weld.

¢ GOST drawing standard
New symbols include GOST Diameter, GOST Plus/Minus, and GOST Degree.

e JIS drawing standard

New weld symbols include the Spot, Seam, Keyhole, Scarf, Stud, and
Continuation Fillet Weld.
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New dialog box for inserting annotation symbols

A new Select Symbols and Values dialog box selects, previews, and inserts annotation
symbols and model-derived values directly into an annotation, dimension, or other
text. Use this dialog box to generate drawing and reference symbols, and to extract
model-derived content, without having to type property text codes yourself.

You can open the Select Symbols and Values dialog box from command bars and from
dialog boxes used to place callouts, feature control frames, weld symbols, dimension
prefixes, and text, as well as drawing view captions and tables. Look for this button:

Symbols and Values

Associative sheet scale from first drawing view

Now when you create a drawing view of a part or assembly using the View Wizard
command, the drawing sheet scale is set automatically to the scale of the first
drawing view—the principal or primary view—placed on the sheet. The same
scale is applied automatically to all subsequently placed views. This maintains a
consistent sheet scale across all drawing views.

Previously, the sheet scale was reset every time a drawing view was placed.
The following new options are available on the Drawing View Wizard command bar:
e Set Sheet Scale

Sets the sheet scale to match that of the drawing view being placed. This scale is
associative to all views placed on the sheet.

e Set View Scale

Sets the scale of the new view to match the current sheet scale.

You can use the new Set Sheet Scale command to set an associative sheet scale
based on an existing drawing view or to change the drawing view that the sheet
scale is associated with. This also lets you choose the scale to be shown in the Scale
box in the drawing title block.

The Sheet Setup dialog box now has a check box—Change the sheet scale
manually—to override the current sheet scale. This lets you set the sheet scale
independently of the drawing view scale. It also removes any existing associativity
between the sheet scale and a drawing view scale. It does not, however, change
any drawing view scales.

Refer to the following related help topics for information:

¢ For an overview, see Sheet scale and drawing view scale.

¢ To learn how, see Set drawing sheet scale.

Automatic balloon stacks for fasteners
You can arrange fastener system balloons automatically in horizontal or vertical

stacks. You can do this when placing a ballooned parts list or when adding balloons
manually with the Balloon command.
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To learn how, see Stack balloons.

Automatic labeling and sorting for view annotations

Labeling of viewing plane lines, cutting plane lines, detail envelopes, and datum
frames is improved in ST4. Now you can:

Release-Notes-1040

Assign labels automatically based on the alphanumeric characters you choose
in the Specify Annotation Letters dialog box. You can define four different
sequences of any combination of uppercase and lowercase letters and numbers,
and you can assign a different labeling sequence to different view annotations.
The labels can be assigned automatically according to a user-defined order or
in the order they are created.

Specify the order in which labels are generated using the following options on
the Annotation tab (Solid Edge Options dialog box).

Follow object creation sequence

Assigns names based on the order in which annotation objects are generated.
This is the previous behavior.

Follow defined object sequence

Assigns names to annotation objects based on a user-defined order. You can
use the Define Object Sequence dialog box to specify the order.

Specify view annotation caption content using property text and formatting as
part of the drawing view caption enhancements using the new Drawing View
style. The view annotation labels are displayed within the view annotation
caption.

To learn how, see the following Help topics:
— Define drawing view captions using property text
— Define annotation labels

Modify label text and formatting for a selected view annotation using the new
Caption tab (Viewing Plane, Detail Envelope, Cutting Plane Properties dialog
box).
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Note

When Draft documents created in previous versions of Solid Edge are opened
in ST4, Follow object creation sequence is applied, and the default label letters
in the Specify Annotation Letters dialog box are also used.

Balloon stack edit handles

Edit handles provide controls for manipulating balloon stacks.

ﬁx ®

See the Balloon stack edit handles section in the Balloons help topic.

Break line enhancements for broken views

Several enhancements are available for broken views created with the Add Break
Lines command in ST4:

e  You can use both horizontal and vertical break lines in the same view.

L —

¢ A new break line type produces short, curved break lines.

T S.5' \
Ol C

* You can control the height and the pitch of short curved and linear break lines.

¢ Options in the Drawing View Properties dialog box control the visibility of break
lines and cropped edges caused by the break lines in a broken view.
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¢ Break lines are confined to the model geometry; they no longer cross empty space.

To learn how, see Create a broken view.

Callout text formatting enhancements

Full text formatting capabilities are available for all callouts in the Draft
environment and for model PMI.

In the Callout Properties dialog box, you can use the following options on the Text
and Leader tab to change the font size of the callout text:

e Aspect ratio
Adjusts text size by changing the font width. The height remains constant.
This option is not yet supported for PMI callout text.

e Text scale
Adjusts text size by changing both the width and the height.

A new Border tab provides the following options to control the behavior of callout
text within the callout box:

¢ Show border outline

Displays a callout border around the callout text.

¢ Gap between border and text

Controls horizontal and vertical spacing inside the callout box.

¢ Fit width to contents

Automatically adjusts the callout box width to match the callout text width.
When the callout border is shown, it changes size along with the text.

¢ Fixed width

Maintains a specific text box width even when the content gets longer or shorter.
You can use either of the following methods to do this:

— Automatic text wrap.

— Automatic aspect ratio adjustment.
Note

The Fixed width option is not supported for PMI callouts. PMI callouts
are always Fit width to content.

Many of these options are also available on the Callout command bar. To learn more,
see Formatting callout text and border.
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Callout edit handles

Edit handles now provide full control for manipulating callouts.

(B) (C) (©)

L /
r

—1234567890¢

(A)
Handle location Purpose
(A) Moves the start point of the leader along the annotated
. element.
Annotation
connection point Pressing <Alt> disconnects the leader and removes
associativity.
Pressing <Alt+Ctrl> disconnects the leader, yet preserves
associativity.
To learn how, see Move an annotation.
(B) Moves the callout text freely by moving the break line.
Leader edit point Changes the leader line length and orientation.
Inserting vertices adds edit points.
To learn how, see Move an annotation.
© Lengthens or shortens the break line.

Break line edit point <>
» 1234567890

Flips the callout and break line to the opposite side of the
leader.

z;f._m.-'qu. va 23456 1890
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Handle location

Purpose

(D)
Callout edit point

Changes the callout width.

Available only when using a fixed width callout.
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Closed option for Curve command

When drawing or sketching, a new Closed option on the Curve command bar creates
closed, B-spline curves.

Closed option

Result
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For more information, see the Curve command Help topic.

Control rib hatching in section views

Various drawing standards call for cut ribs not to display with hatching in section,
broken-out section, and revolved section views. This is often the case when the
cut is along the rib, not crossing the rib.

In ST4, you can specify whether the ribs and rib-like features created with the
following commands are cut and hatched or not hatched:

e Rib

¢ Mounting Boss

e  Web Network

¢ Pattern (containing ribs)
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When you choose the no hatching option, then you also can use the Override Rib
Hatching dialog box to selectively identify individual ribs for display using the hatch
style. To learn how, see the Help topic, Set rib hatching in section views.

You can use the following options to specify that ribs are hatched or not before you
create the section view:

e By setting a local property on the Advanced tab (Drawing View Property dialog
box).

e As afile preference set on the Drawing Standards tab (Solid Edge Options dialog
box). This preference is set to no hatching in all templates except for the ANSI
template.

Note

Rib hatching control is available for parts created beginning in ST4. It also
is available for legacy files that contain ribs, if you first use the Recompute
command to update the ribs.

Dimension enhancements

Many enhancements are available for dimensioning commands in ST4.

The following options can be set on the Text page in the Dimension Style dialog box,
and they can be modified in the Dimension Properties dialog box:

¢ Override pulled-out text 2

Provides horizontal text alignment for dimension text pulled outside the
projection lines or terminators.

[
—_—

B

¢ Display degree symbol after numeric angular tolerance values

When units are set to degrees-minutes-seconds, the degree symbol ° now can be
appended automatically to the angular tolerance value when it is displayed with
an Angle Between dimension.
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The following option can be set on the Units page in the Dimension Style dialog box,
and it can be modified in the Dimension Properties dialog box:

Zero inches for ft-in

Specifies that a zero (0) is displayed when units are set to feet and inches and
the inch value is zero with a fractional round-off.

Example

If the distance is 12.25 inches, and the units are set to ft-in with a
fractional round-off, then the dimension displays as 1'-0 1/4”.

The following options are available on the command bar:

Release-Notes-1040

New dimension type: Hole callout

The Hole callout dimension type is available for hole and thread dimensions
placed with the Smart Dimension, Distance Between dimension, or Symmetric
Diameter dimension command. When you select the Hole callout dimension
type and place a dimension on a hole edge, outside edge, or threaded hole, the
nominal dimension value is replaced with the hole callout definition (%HC)
from the dimension style.

— Ifthe %HC definition includes thread size, then that information is included
in the dimension text. Previously, you had to enter thread size in the
dimension prefix.

—  You can modify the hole callout and thread size dimension text using the
Hole Callout tab and the Smart Depth tabs of the Dimension Properties
dialog box.

Change radial to diameter

Now you can change dimension measurement display from radial to diameter,
and from diameter to radial, using the Radial and Diameter buttons on the
command bar:

= -+
£ G

—
<

Previously, you had to delete the dimension and recreate it to change the
dimension measurement.

Show or hide dimension prefix
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Now you can use the Enable Prefix button on the command bar to show or hide
the content defined in the Dimension Prefix dialog box, without having to open
the dialog box itself.

Other dimensioning enhancements include the following:
¢ Add jogs to projection lines

You can use Alt+click to insert jogs into either or both of the parallel dimension
projection lines of linear dimensions, symmetrical diameter dimensions, or
circular diameter dimensions.

I : - | :
‘ 89,88

To learn more, see Adding breaks to dimension projection lines in the help topic,
Dimensioning overview.

¢ New command: Copy Attributes

The Copy Attributes command copies the style properties of a selected dimension
or annotation.

This command previously was called the Prefix Copier command.

¢ Right justification for subfix

In the Dimension Prefix dialog box, the Subfix horizontal alignment list now
offers a Right justification in addition to Left and Center.

Drawing view caption enhancements

Many enhancements have been made to drawing view captions. These are available
for all drawing standards.

e Formatting of all drawing views, captions, and view annotations is defined and
applied using a new style: Drawing View.

Previously, drawing views obtained their formatting instructions from the
Dimension style.

e Automation to display the following information in a caption:

— View scale, when it is different from sheet scale.
— View rotation angle, when it is not 0 degrees.

— Drawing sheet number, when a derived view is moved to a different sheet
than its parent.

¢ Primary and secondary caption enhancements:

—  Multiline primary caption text.

1-50 ST3 Release Notes Release-Notes-1040


sesync.chm::/dim4a.htm
sesync,chm::/prfxcp1c.htm
sesync.chm::/view_annotation.htm

What’s New in Solid Edge ST4

— Separate secondary caption, such as for text comments below a view name.

— Independent formatting for font, font size, font color, font style, and text
alignment.

— Horizontal separator between primary and secondary captions.

— Caption location above or below the view.

Rotated view mark, such as |iJ or |EJ

e (Caption text derived by property text strings, for example:

— Drawing view scale, view name, and view rotation.

— View annotation name labels and view name index with numeric extension
and subscript formatting.

¢ Line style formatting for drawing views and view annotations incorporated
into the drawing view style.

* Automatic labeling and sorting for view annotations.

These are defined using the new Specify Annotation Letters dialog box.

To learn more, see these help topics:

e For an overview, see Drawing view captions.
e For an overall workflow, see Drawing view style workflow.

e To learn how to create captions using the new Drawing View style, see the Help
topic, Define drawing view captions using property text.

Note

Drawing view captions in previous versions of Solid Edge are converted
automatically to the new, property-text based format, without visibly changing
the caption itself.

Empty-callout visibility
Empty callouts now are marked by a unique symbol. This makes it possible to

locate and select a callout without content—a null callout—even when the callout
does not contain a leader line.

The empty callout symbol looks like this:
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The empty callout symbol does not print. If a leader is attached, however, the
leader is printed.

e

In the Draft environment, the default symbol color is derived from the Disabled
element color on the Colors page (Solid Edge Options dialog box). For PMI callouts
in the modeling environments, the default color is derived from the Sketch color.

Feature control frame improvements

A variety of improvements to feature control frames provide flexibility in placing
and orienting the annotations.

e Feature control frame structure

There are four rows available on the General page, Feature Control Frame dialog
box for creating a feature control frame. Individual Composite check boxes
control whether a row is part of a composite feature control frame structure.

i

e
ra 1
-

¢ Feature control frame alignment

You can use the Orientation list on the Feature Control Frame command bar
to align the feature control frame to the surface, edge, or dimension that it
references. Options are parallel or perpendicular, horizontal or vertical.

¢ Leader line attachment points

There are nine snap points on a feature control frame to connect the leader
to the frame. You can change the leader attachment point to any of the snap
points using Alt+drag.

[

When you use a break line with the leader, only eight points are available:
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¢ Break lines

Break lines can be horizontal, vertical, or inclined. An Angle box on the
command bar specifies an incline orientation for a break line.

e Edit handles

New edit handles are available for manipulating a feature control frame.

(©)
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Handles for reattaching center lines

New handles are available for reattaching center line annotations when they become
detached due to changes in the model. See the Center Line command help topic.

For better visibility, detached center line, center mark, and bolt hole circle
annotations now are displayed on the drawing using the Error Dimension color set
on the General page (Dimension Style dialog box). When reattached, they display
using the Driven Dimension color.

Leader command enhancements

When you add a leader line with the Leader command, you can control the
orientation of the leader and the break line.

*  You can use the Orientation list on the Leader command bar to specify a vertical
or horizontal break line.

¢  You can further adjust the incline of the break line segment of the leader by
typing a value in the Angle box on the command bar.
The Angle option also is available when placing a feature control frame.

¢ You can drag any segment of a multi-segment leader line so that it snaps

perpendicular to the previous or next segment. This does not apply to the break
line.

Line style control for boundary edges

Now you can apply a thin-line style to hatch boundary edges in broken-out views
that are created using the same view to draw the profile and to apply the section.
This also applies to the boundary edges in a cropped drawing view.

Use the following options on the Annotation page (Drawing View Properties dialog
box) to control the line style:

¢ Show boundary edges check box—When selected, the boundary edges display
using a thin-line style. When deselected:
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— Hatch boundary edges display using the Visible edge style setting on the
Display page (Drawing View Properties dialog box). This is the previous
behavior.

— Cropped boundary edges are not displayed.
¢ Boundary edges style list—Selects the line style to apply to the boundary.

You can touch up the boundary edges using the Edge Painter, Show Edges, and
Hide Edges commands.

Locked drawing views

To prevent accidental movement of a drawing view, you can use the Lock drawing
view position option that is available:

¢ As a check box on the General page (Drawing View Properties dialog box), when
you edit the drawing view properties.

e As a Lock button on the Drawing View Selection command bar, when you select
the drawing view border.

A locked drawing view is indicated by the lock symbol displayed within the drawing
view border when it is highlighted.

Locked drawing views still can be manipulated. See the help topic, Drawing view
manipulation.

New command: Copy Attributes

i
The new Copy Attributes command, which is located in the Dimensions group
on the Home tab and on the Sketching tab, copies the style properties of a selected
dimension or annotation to another dimension or annotation.

This command previously was called the Prefix Copier command.
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New command: Set Sheet Scale

You can use the new Set Sheet Scale command to set the sheet scale for a new
drawing sheet or for a drawing sheet that already contains drawing views. This
command is available from the shortcut menu when a drawing sheet tab is selected.

You can specify a sheet scale that is associative to a drawing view scale, or you can
specify a user-defined sheet scale by typing or selecting a scale value.

Refer to these new help topics:

e For an overview, see Sheet scale and drawing view scale.

¢ To learn how, see Set drawing sheet scale.

New style: Drawing View

A new Drawing View style provides flexibility when specifying formatting for
drawing views, view annotations, and caption text. Previously, these objects obtained
their formatting instructions from the Dimension style.

* You can use the Styles command and the Drawing View Style dialog box to
create a different drawing view style for each type of drawing view.

To learn how, see the Help topic, Create or modify a drawing view style.

¢  You can use the mapping table on the new Drawing View Style tab (Solid Edge
Options dialog box) to select the drawing view style that you want to apply to
each type of view you place on a drawing.

To learn how, see the Help topic, Map drawing view styles.

¢  You can modify the properties of a drawing view or view annotation. A new
Caption tab in the Drawing View Properties dialog box modifies the drawing
view caption and view annotation caption defined in the drawing view style.

To learn more, see Drawing view styles.

Legacy conversion to the new drawing view styles

The new drawing view styles are generated automatically the first time that Draft
documents created in earlier versions are opened in ST4ST4. The new drawing view
styles are generated from the Dimension styles that exist in the document or the
document template. In this conversion process, the Dimension style names and style
formatting are converted to the structure of the new Drawing View style.
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New style for hatches and fills: Wood (radial)

A new style—Wood (radial)—uses concentric circles to mimic the circular growth-ring
pattern of a crosscut tree trunk. The Wood (radial) pattern is available as a hatch
style and as a fill style in the Part, Sheet Metal, Assembly, and Draft environments.
The Wood (radial) fill style also appears in the previews of wood materials in the
Material Table dialog box.

g

Using the Pattern tab (Hatch Style and Fill Style), you can:
¢ (Change the appearance of the Wood (radial) style.

¢ Combine two or more radial patterns to form a new style.
e (Combine the radial and linear hatch patterns to form a new style.

¢ Control all elements of the radial pattern, including dash type, spacing between
circles, the center of concentric circles, and overall width.

e Use the fill handle located on a radial hatch pattern to drag the radial pattern
onto another object.

To learn how, see Create a hatch style.
Note

You now can edit a system defined hatch style, and you can use the Undo and
Redo commands to undo and redo changes.

Parts list and table enhancements

A variety of options have been added by customer request and to meet the
requirements of the ESKD and GB drawing standards. Except where specifically
noted, these enhancements are shared by parts lists, user-defined tables, bend
tables, and family of parts tables.

To learn how to use many of the new options, see Formatting columns and data cells.
Table titles

For each title in the table, you can:
¢ (Change the font, font style, and text size independently of the table title style.
e Specify that the aspect ratio adjusts automatically based on cell width.

Column headers

Structural improvements to individual column headers include:
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e  Multiple rows for each heading.

e Header cells that span multiple columns (merging).
¢ Rotated and vertical heading text orientation.

e Automatic text aspect ratio adjustment.

¢  Unique column heading line style definition in the table line style.

(T1)
(H1)
(H2) (H2)
1 9
45 32
113 0
— 17

Table data cells

The following data cell editing capabilities are available on the Data tab:

e Font, font style, and justification formatting

¢ Two new shortcut commands to enable and disable data cell editing:

— Allow Cell Overrides
— Clear Cell Overrides
e Vertical data cell merge when the value in two adjacent rows is the same

User-defined row insertion into model derived tables

Now you can insert user-defined rows into model-derived tables, such as parts
lists, bend tables, and family of parts tables. The rows may contain information
or they may be blank. They may be used to organize data and to improve
legibility through the use of white space.

Display configuration for parts lists

Now you can choose a model configuration to control what is displayed in the
parts list. Selecting a predefined assembly configuration sets options for how
subassemblies are treated in the parts list, what is included and excluded, what
is shown or hidden.

The Configuration option is available on the List Control tab (Parts List
Properties dialog box) .
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Categories to group parts lists

You can define custom properties in part documents to group parts into
categories, such as fittings, purchased parts, and fasteners. You can then insert
those properties as custom columns into parts lists.

To learn how, see the Help topic, Example: Show custom properties in a parts list.
Show drawing view geometry during move

Now you can show drawing view geometry while moving (dragging) a drawing view
to reposition it:

e

L

Previously, only an empty rectangle representing the drawing view boundary was
displayed:

———

B

Drawing views with complex geometry take longer to move than do those with
simple geometry. A new option on the View page, Solid Edge Options dialog box
adjusts the maximum elapsed time for geometry to display.

Tip

You can specify that geometry is never displayed when a drawing view is
moved by setting this value to 0.00 milliseconds.
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Support for ESKD and GB drawing standards

Solid Edge ST4 provides extensive changes in Draft and 2D Drafting to support
the Russian (ESKD) and Chinese (GB) drawing standards. Among these are
enhancements to the following drawing functions:

Template updates for the ESKD and GB styles.
Annotation symbol enhancements

Automatic generation of user-defined captions

Automatic balloon stacks for fastener system components
Dimension enhancements

New hatch style: Wood (radial)

Underline balloons

Text box formatting enhancements

A variety of new text box formatting capabilities are available directly from the Text
command bar when you select the Text command:

Release-Notes-1040

1 i-_

S
Stacked text y for fractions, superscript, and subscript. There are two new
dialog boxes:

— Use the Stack dialog box to define stacked text formatting.

— Use the Auto Stack dialog box to specify automatic stacking instructions
when you type fractional numbers and characters.

Symbol insertion, such as degree, diameter, and radius.

Use the Select Symbols button - on the command bar to open the new Select
Symbols and Values dialog box.

Bullet and numbered lists.

|a— ]

Use the Bullets and Numbers button = on the command bar to choose a
bullet for a bullet list and to start and start numbering for a numbered list.

Two new tabs on the Text Box Properties dialog box also specify list formatting:

— Use the Bullets and Numbering tab to format bullet and number lists.
— Use the Indents and Spacing tab to format paragraphs.

Special character insertion, using different Microsoft fonts.

Use the Insert Character button on the command bar to open the Character
Map dialog box.
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e Vertical and rotated text rotation.
e Text box border display.

e Text controls to fit the text within the text box:
— Fit the text box to the contents.

— Maintain a fixed text box size by wrapping the text or adjusting the aspect
ratio.

See these help topics to learn more:

¢ Place a text box or text string
e Format a text box
¢ Format a fraction, superscript, or subscript

e Format a bulleted or numbered list
Note
Fractions, bulleted lists, numbered lists, tabs, and paragraph indentation
are not yet supported in Hebrew and Arabic.

Undo and Redo for deleted drawing views

Now you can use the Undo command and the Redo command in Draft for:

¢ Deleted drawing views.

¢ Deleted parts lists.

¢ Deleted bend tables.

Undo and Redo work for other kinds of operations, as well, but not all operations
can be undone or redone.

Printing enhancements

Several enhancements have been made to the user interface associated with printing
draft files:

¢ A new Preview button on the Print dialog box displays the Preview Composite
dialog box for you to verify the sheet layout of each page of the drawing.

e The Settings button on the Print dialog box has been renamed to the Options
button.

¢ The (Print) Settings dialog box has been renamed to the (Print) Options dialog
box.

¢ The Preview button on the Print Drawings - Select Sheets dialog box is now
enabled when the Single sheet per page option is selected. In previous versions,
the button was enabled only when the Multiple sheets per page option was
selected
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¢ A new Zoom slider has been added to the Preview Composite dialog box to
dynamically zoom in or out of the drawing sheet preview. Sliding the arrow to
the right zooms in on the preview and sliding the arrow to the left zooms out on
the preview.
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File level changes

« .
"~ File-level enhancements for all documents

These usability enhancements were made to file-level functions across all
environments in Solid Edge ST4.

Save As to 3D Adobe Acrobat Document (*.pdf) now available in all 3D
environments

E Enhancements to Recent Documents

Save As to 3D Adobe Acrobat Document (*.pdf) now available in all
3D environments

You can now use the Save As command to save the current view of Solid Edge
assembly, assembly weldment, part, and sheet metal files to 3D Adobe Acrobat
Document (*.pdf) format.

Note
Weldment (.pwd) format is not supported.

For more information, see the Saving Solid Edge documents to other formats help
topic.

Enhancements to Recent Documents

You can now preview Solid Edge assembly, weldment, part, and sheet metal files on
the Recent Documents list. You can also control the number of documents shown
in the Recently Used Files list as well as retain files on this list. See the Recent
documents help topic for more information.
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User interface changes
These enhancements were made to the user interface in Solid Edge ST4.

fel Keypoint enhancements
[ Orientation triad improvements
[] Mouse wheel dimension change improvements

E Middle mouse button and wheel enhancements

] Floor reflection display
Improved cylinder faceting

E User defined command defaults now stored

[ Improved keyboard shortcut customization
[] User defined edge color display

fel High quality view style

Keypoint enhancements
e The keypoint symbols are now colored black with a white background.
¢  When hovering over a keypoint, the keypoint symbol remains displayed.

¢  When creating extruded features or moving selected faces, the M C E shortcut
keys can be activated by pressing the K key. Even if the keypoints are turned
off in command bar, the K key overrides this setting. Press the K key again
reverts to the initial state.

See Help topics:
Selecting and snapping to keypoints
Snap to a keypoint
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¢ Locating a cylinder edge finds the axis point for complex edges.

¢ Added more useful displayed descriptors when locating a keypoint.

Orientation triad improvements

The orientation triad moves from the lower left portion of the screen to the lower
right portion of the screen when the area under a pinned transparent PathFinder
covers up the triad. The triad does not move during a dynamic drag of the
PathFinder. It updates when PathFinder drops into position. The changes to the
orientation triad position are in all 3D environments where the triad is displayed.
The orientation triad favors the lower left corner for its position.

Mouse wheel dimension change improvements

The mouse wheel behavior is now consistent across all environments. On the Solid
Edge options®Helpers page, the mouse wheel option has new text. “Enable value
changes using the mouse wheel. (Ctrl+mouse wheel overrides this setting)”. The
default option is now off. When the option is off (new behavior), zoom in and out with
the mouse wheel. If an edit field has focus, Ctrl+mouse wheel performs a value
change. You can position the cursor over the value field to change the value with
the mouse wheel. When the option is on (old behavior), you can change a value
with the mouse wheel regardless of cursor position. Ctrl+mouse wheel performs a
zoom in and out function.

Middle mouse button and wheel enhancements

The middle mouse button or wheel provides improved model rotation. You can now
select a vertex, edge, or face as the model rotation center.

See Using the mouse for more information.
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Floor reflection display

You now have the ability to turn on a mirror reflection of models. This is represented
by a floor plane parallel to the XY plane of the model.

Within the View tab®Style group®View command, select the Floor mirror option
on the Rendering tab.

Improved cylinder faceting

The reduction in the deviation between arcs and their component chords is improved,

resulting in smoother cylinder edges. You can change the Auto-sharpen setting in
the Solid Edge options dialog box on the View tab.

User defined command defaults now stored

Many command options set by the user are now stored in UserPreferences.xml,
located in the application data folder of the operating system that Solid Edge is
loaded on.

Example

C:\Users\username\ AppData\Roaming\ Unigraphics Solutions\Solid
Edge\Version 104\

See Command options for more information.

Improved keyboard shortcut customization

Keyboard shortcuts for Solid Edge commands are now easily customized in the
Customize dialog box. See Customize the keyboard for more information.
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User defined edge color display

You now have the ability to define a specific color for model edges.

See the Help topic Single Color Edges command for more information.

High quality view style

Solid Edge now contains a high quality, or presentation view style. The first image
contains default view style settings; the second image contains the custom high
quality settings.
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See the Help topic View Styles command for more information.
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Translator and converter enhancements
These enhancements were made to translators and converters in Solid Edge ST4.

] New Inventor part and assembly translator now available

New parameter to control internal healing now available

New parameter to redefine the block origin now available

[l New parameter to export the text in the unblocked state now available

] New parameter to break B-spline curves at duplicate control points during
import now available

(%] Enhancements to importing AutoCAD multiline text

Enhancements to exporting multiline text to AutoCAD

New Inventor part and assembly translator now available

A new translator is available to open Inventor part and assembly documents directly
in Solid Edge.

For more information, see the following Help topics:

¢ Importing Inventor part and assembly documents to Solid Edge

New parameter to control internal healing now available

A new parameter, Import Internal Healing Enabled, is now available in the .ini files
for the 3D data translators for STEP, Pro/Engineer, Catia V4, and IGES. Valid values
for the parameter are On and Off, with the default for the parameter being On.

New parameter to redefine the block origin now available

A new parameter, Modify Block Origins on import, is now available in the seacad.ini
file that redefines block origin when importing AutoCAD files containing blocks. The
new origin is based on the range of elements within the block and is defined at

the lower left corner or the range. The default value for the parameter is 1, which
modifies the block origins on import. You can set the value to 0 if you do no want

to modify the block origins on import.

New parameter to export the text in the unblocked state now available

A new parameter, Export Single Line Text Without Block, is now available in the
seacad.ini file that exports single line text in the unblocked state. The default value
for the parameter is 0, which creates blocks for all text and callouts. You can set the
value to 1 if you want to export text and callouts in the unblocked state.
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New parameter to break B-spline curves at duplicate control points
during import now available

A new parameter, Break BSplines At Duplicate Control Points On Import, is now
available in the seacad.ini file that breaks B-spline curves at the point where
duplicate control points exist. The default value for the parameter is 1, which breaks
the B-spline curves at the duplicate control points. You can set the value to 0 if you
do not want to break B-spline curves at the duplicate control points.

Enhancements to importing AutoCAD multiline text

Enhancements have been made when importing AutoCAD multiline text. A new
parameter, Multiline text as Multiline text, has been added to the seacad.ini to
control how Solid Edge imports AutoCAD.multiline text. By default, the parameter
is set to 1, which imports multiple lines of text within a single text box. You can set
the parameter to 0 to import multiline text as multiple single line text boxes grouped
together, as done in previous versions.

Enhancements to exporting multiline text to AutoCAD

Enhancements have been made when exporting Solid Edge text boxes to AutoCAD.
A new parameter, Export Multiline Text As Multiline Text, has been added to the
seacad.ini to control how Solid Edge exports multiline text boxes. By default, the
parameter is set to 1, which exports text boxes as multiline text boxes. You can set
the value to 0 if you want to export text boxes as single line text boxes.
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User assistance tools

[ Self-paced training is available online
[ Tutorials are available in Solid Edge
| Where is user help?

[ Contextual Help

Self-paced training is available online
Working at your own pace, from your own desktop, teach yourself the basics of

part and assembly modeling, and drafting with these overviews, animations, and
activities. Work through the self-paced training online or download a course PDF file.

The link to self-paced training is located on the Help pane. To find it:

1. On the ribbon, click the Help index icon i

2. In the Help pane, under Learning Tools, select Solid Edge Self-Paced Training.

Tutorials are available in Solid Edge

The tutorials have been updated for Solid Edge ST4.

The link to tutorials is located on the Help pane. To find it:
1. On the ribbon, click the Help index icon i

2. In the Help pane, under Learning Tools, select Solid Edge Tutorials.

Where is user help?

All online user help books, tutorials, training catalogs, and technical support links
are located in their own dockable Help window. You can find it by clicking the Help

@

Index button ;, which is located at top-right on the ribbon.

Contextual Help

¢  You can press F1 whenever you need online Help during a design session.

¢  You can press Shift+F1 to initiate context help [\L\? When this tool is displayed,
you can click a command on the ribbon to display online help. Another way

to display this tool is to choose Context Help in the new Help window, under
Learning Tools.
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What’s New in Solid Edge ST4

Administering Solid Edge

This section of What’s New provides Solid Edge administrators with a quick
overview of features of the new release.

Licensing
For detailed information, you can access the Solid Edge License Management web

site at: http:/www2.ugs.com/Support/LicenseManagement. A web key is required
to access the site.

Support

Detailed information is now available from the web site:
http://support.ugs.com/services/GTAC_Support_Services_Guide.pdf.
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Operating system requirements and information

Solid Edge ST4 has been certified to run on the following:
e  Windows XP Professional operating system (32-bit or 64-bit) with Service Pack 3

e Windows Vista Business or Vista Enterprise operating system (32-bit or 64-bit)
with Service Pack 2

e  Windows 7 Enterprise, Ultimate or Professional (32-bit or 64-bit) with Service
Pack 1

e Internet Explorer 9 (IE 6.0 meets minimum requirements)

Note

Internet Explorer is not required to be the default browser.

Note

The Alvira freeware anti-virus program on Windows platforms occasionally
misidentifies some NX DLLs as contaminated with a virus. If you are using
Alvira and NX on a Windows machine and encounter this problem, please use
the Alvira option to exempt the files from scanning by Alvira.
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Hardware system requirements

Solid Edge is not supported on Intel Itanium processors.

Recommended system configuration
e 32-bit (x86) or 64-bit (x64) processor

e Windows 7 operating system for optimal performance and user experience
e At least 2GB RAM

e True Color (32-bit) or 16 million colors (24-bit)

e Screen Resolution: 1280 x 1024 or higher, widescreen format

e 3 GB disk space required for installation

Minimum system configuration

e 32-bit (x86) or 64-bit (x64) processor

¢ Any of the above operating systems

e At least 1GB RAM

¢ 65K Colors

e Screen Resolution: 1280 x 1024 or higher
e 3 GB disk space required for installation

Solid Edge stops certifying new releases against an operating system shortly after
Microsoft drops mainstream support for it. Microsoft dropped mainstream support
for XP in April 2009. Solid Edge ST4 is the last version to install on Windows
XP. For ST4, we will not address XP operating system related issues or provide
XP-specific fixes. Solid Edge ST5 will not install on XP.

It is not recommended that you run Solid Edge on Server operating systems.

Solid Edge will not install on machines without Internet Explorer 6.0 or higher.
Internet Explorer is not required to be the default browser.

Solid Edge is not supported on Intel Itanium processors.

The 64-bit version of Solid Edge requires Microsoft 64-bit Windows XP, 64-bit
Windows Vista, or 64-bit Windows 7 operating system loaded on Intel EM64T or
AMDG64 processors. (More details are below under System Resource Requirements
and Information.)

The 32-bit version of Solid Edge has been certified to run on 64-bit Windows XP,
64-bit Windows Vista, or 64-bit Windows 7 as a 32-bit application. Below are the
known issues running on these operating systems. The workaround is to use the
32-bit Internet Explorer.

e The "Status" and "Project" tabs are not displayed on the File Properties dialog
if activated from Windows Explorer.
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e  Solid Edge Web Parts do not display if running the 64-bit version of Internet
Explorer. The user is prompted to install the NET framework.

Release-Notes-1040 ST3 Release Notes 2-5



Chapter 2 System requirements

Windows 7 and Windows Vista Recommendations

User Account Control (UAC)

The User Account Control (UAC) on Windows 7 and Windows Vista prevents the
proper installation and removal of Solid Edge.

The Solid Edge installation performs best with UAC be set to off. If you plan to
run Solid Edge with UAC on, you should install the Solid Edge application to a
location where the user has write permissions. This location should be somewhere
other than c:\Program Files.

To turn off UAC on Windows Vista, select Control Panel -> User Accounts ->User
Accounts -> Turn User Account Control On or Off.

To turn off UAC on Windows 7, select Control Panel -> User Accounts -> Change
User Account Control settings -> “Never notify”.

Windows Vista Aero

It is strongly recommended that you turn off Windows Vista Aero if you will be
working with View and Markup or the Solid Edge Viewer. To turn off Windows
Vista Aero, follow these steps:

[0  Go to Control Panel.

O If Control Panel Home is selected at the far left of the screen, then click
Appearance and Personalization, click Personalization, and then click Window
Color and Appearance.

0 If"Classic View" is selected at the far left of the screen, then click Personalization,
and then click Window Color and Appearance.

U If you see Window Color and Appearance at the top of the window, then you
should have "Open classic appearance properties for more color options" at the
bottom of the window. Click it. In the Appearance Settings window, change the
color scheme from Windows Aero and click OK.

O If you don’t see Window Color and Appearance, but see Appearance Settings,
then check to make sure the Color scheme is not set to Windows Aero and click
OK.

Note

If you see the Appearance Settings dialog box instead of the Window
Color and Appearance window, then the theme might not be set to
Windows Vista, the color scheme might not be set to Windows Aero, or
the computer might not meet the minimum hardware requirements for
running Windows Aero.

Windows Vista Aero requires a DirectX 9—class graphics processor that supports
the following:

e WDDM driver

¢ Pixel Shader 2.0
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e 32 bits per pixel

e 256 MB graphics memory
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Display System Requirements and Information

Solid Edge will run on graphics drivers that support Windows XP or Windows Vista
or Windows 7. Contact your graphics driver manufacturer to determine whether
their graphics adapter/driver support these operating systems.

For optimal performance, it is recommended to use a professional graphics card that
is designed for CAD applications. For information about cards used in testing Solid
Edge and results, refer to http:/support.ugs.com/online_library/certification/.

At least a 256MB graphic card is recommended when working with large assemblies
or complex parts.

Note that running with extremely high screen resolution and color depth increases
the memory requirements on the system and may result in apparent performance
degradation. If experienced, reconfigure the display system to the recommended
resolution and color depth for improved performance.

When running Solid Edge, if you experience an abnormally high
abort rate, parts disappearing, or other graphic anomalies you may
not be using the appropriate graphics driver. For more details, visit
http://support.ugs.com/online_library/certification/.

Also setting Display Fonts to Large Fonts or Extra Large Fonts (larger than 96
DPI) may cause some Solid Edge user interface items to not display as intended.
Recommendation to resolve these would be to use Normal Fonts (96 DPI).

A wide-screen ribbon layout has been added for Solid Edge. This new ribbon

layout is optimal for horizontal screen resolutions set to 1920 or above. Solid Edge
automatically detects your resolution and sets the ribbon layout to wide-screen
starting at horizontal resolutions 1600 and above. You will see some group collapsing
on the right side of the Ribbon on resolutions between 1600 and 1920.
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System Resource Requirements and Information

Earlier versions of Solid Edge were enhanced to access the extended address space
that is available on Windows. All running processes, including the Operating System
process, share 4 GB of addressable memory available, regardless of the amount of
physical RAM. Normally, the operating system reserves 2 GB of space and leaves 2
GB for applications. Running 32-bit operating systems with the /3GB switch added,
reserves only 1 GB for the operating system, and leaves 3 GB for applications. This
allows you to work with larger datasets without running out of addressable space.

On XP, you set the /3GB switch by editing the boot.ini file. You must have admin
privileges to do so. Here is a sample boot.ini that contains a 3 GB switch.

[boot loader]

timeout=30

default=multi (0)disk(0)rdisk(0)partition (1) \WINDOWS

[operating systems] multi(0)disk(0)rdisk(0)partition (1) \WINDOWS="Microsoft Windows XP Pz
/fastdetect /NoExecute=OptIn multi (0)disk(0)rdisk(0)partition (1) \WINDOWS="Microsoft Windc
/fastdetect /NoExecute=OptIn /3GB

On Vista with administrator privileges, you can run the following command from the
command line to enable /3GB switch:

BCDEDIT /Set IncreaseUserVa 3072

This command will tell you what options are part of the OSLOADER family:
bededit /? types osloader

To reset the value, use:
bededit /deletevalue IncreaseUserVa

With Solid Edge V18, we announced support for running our existing 32-bit Solid
Edge application on Microsoft Windows XP Professional x64 Edition with Intel
EM64T or AMD64 processors. This allowed Solid Edge customers to address 4 GB of
physical memory and virtual memory. With Solid Edge V19, we developed a new
64-bit Solid Edge application, in addition to the existing 32-bit version. The 64-bit
Solid Edge supports up to 128 GB of physical RAM and 16 terabytes of virtual
memory, enabling applications to work with larger data sets. The 64-bit version of
Solid Edge requires Microsoft 64-bit Windows XP operating system or 64-bit Vista
operating system loaded on Intel EM64T or AMD64 processors. The 64-bit version
of Solid Edge should only be used if you need more than 4 GB of physical memory
because you are running out of memory today when creating very large assemblies
or drawings. The 64-bit version of Solid Edge is available by request.

Page file size should be the maximum size possible. In general, the page file size
should be at least twice the amount of memory in the machine, plus the size of
files you will use.

To better manage the system memory resources while running Solid Edge, it is
important to turn off the option to "Show window contents while dragging". This
prevents unnecessary allocation/deallocation of memory for displaying the window
contents while dragging a window. To change this option, go to Control Panel ->
Display.
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Future Processor Support

Component software delivered with Solid Edge, such as Parasolid and D-Cubed,
started phasing out processors not supporting Intel’s SSE2 (Streaming SIMD
Extensions 2) instruction set. In 2009, these components will only support processors
with SSE2.

SSE2 is one of the Intel SIMD (Single Instruction, Multiple Data) processor
supplementary instruction sets first introduced by Intel with the initial version of
the Pentium 4 in 2001. AMD added support for SSE2 with the introduction of their
Opteron and Athlon 64 ranges of AMD64 64-bit CPUs in 2003.

Here is a list of common processors that do not support the SSE2 instruction set:

e AMD CPUs prior to Athlon 64
e Intel CPUs prior to Pentium 4

Starting with the ST2, Solid Edge only supports processors that include the SSE2
instruction set. The Solid Edge ST4 installation checks for the presence of such a
processor. If this processor does not exist, ST4 will stop the install and display a
meaningful error message.
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Temp File Space

Solid Edge uses temp file space for saving files and for storing memory mapped
display files. Using temp file space when saving files helps significantly reduce the
size of the resulting file on the destination file system.

Users should ensure they have twice the size of the largest file being saved available
as free temp file space prior to saving their files. Note, 2x the file size for an assembly
should include the size of the assembly, plus the size of the subassemblies that are
being used, plus the size of the part files.

Running SE will create files with .000, .001, etc. extensions. These are memory
mapped files that are used in the display pathway. When an assembly or part file is
opened, memory mapped files are created in the temp directory during display of
the assembly/part. These files are cleaned up by Solid Edge when the process exits.
If the user is running short on temp space, they can optionally set an environment
variable called JRENDER_TEMP and point it to any folder with sufficient space. If
this variable is defined, Solid Edge will create memory mapped files in that folder.

Running SE will create a file named DCCACHE.CAC in the system temp folder. This
file is a cache of the file icons displayed on the FILE OPEN/FILE SAVE/BROWSE
dialogs.

When a Solid Edge file is opened, but Solid Edge cannot gain exclusive write access
to that file, a message box is displayed stating, "The requested file is currently write
locked, open as read-only". If the user selects the copy button on this message
dialog, the file will be copied to the temp folder using the naming convention tmp
{filename}.par, tmp{filename}.psm, tmp{filename}.asm, tmp{filename}.dft.

It is good practice to periodically check the files in the temp folder when not running
Solid Edge and delete any that might remain from an abnormal termination of
Solid Edge.
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